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Microsoft Excel is a spreadsheet application that is usually part of 
a suite of Microsoft applications, known as Microsoft Office. 

You can use Excel for all sorts of tasks involving numbers such as 
budgeting, sales analysis, forecasting, charting and graphing and 
much more. Excel is a tool used to perform calculations with 
numbers, so virtually any task that requires calculation and number 
crunching can be setup and performed in Excel. 

Before you start creating anything, it is worth taking some time to 
become familiar with the Excel environment and its features. 

In this session you will: 

✓ gain an understanding of choosing spreadsheet software 

✓ learn how to start Excel from the desktop in Windows 10 

✓ gain an understanding of the Excel Start screen 

✓ gain an understanding of how Excel works 

✓ learn how to use the ribbon to access commands 

✓ learn how to use ribbon key tip badges 

✓ gain an understanding of Backstage view in Excel 

✓ learn how to use shortcut menus 

✓ gain an understanding of how dialog boxes work 

✓ gain an understanding of the Quick Access Toolbar 

✓ gain an understanding of the status bar 

✓ learn how to exit correctly and safely from Excel. 

INFOCUS 
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CHOOSING SPREADSHEET SOFTWARE  
 

 

 

 

  

 

Spreadsheet software allows you to create and 
work with spreadsheets as well as a number of 
elements that make up spreadsheets such as 
formulas and functions. These days there are a 

range of software options for working with 
spreadsheets and it’s important to consider which 
one works best for you. 
 
 

Microsoft Excel 

Microsoft Excel is a software program designed to create and work with spreadsheets. It was created by 
Microsoft and is part of the suite of products known as Microsoft Office. It was originally launched in the 
1980s and today is one of, if not the most popular program for creating and working with spreadsheets. 
You can use Microsoft Excel to create and save spreadsheets, work with formulas, graphs, pivot tables 
and the like. While Microsoft Excel is primarily a desktop application (meaning it is installed and run on 
your desktop computer), Microsoft also provides Excel Online and the Excel mobile app. Excel Online 
can be accessed and used from the browser window if any device connected to the internet, while the 
Excel mobile app can be downloaded and used on any mobile device such as a mobile phone or tablet.  

 

Web Based Spreadsheet Processing Apps 

There are a number of different word processing apps that can be used online. For example; 

Google Sheets - Google Sheets is used in conjunction with Google Drive which is Google’s cloud file 
storage service. You can sign up for Google Drive for free and you will receive 15 GB of storage 
allowance which is used across Google Drive, Gmail and Google Photos. If you require more storage 
you can pay an annual or monthly fee to receive more storage. Google Sheets is a free app created for 
working with spreadsheets and is available to use online or as a downloadable app on your mobile 
device. It is part of Google’s office suite which includes Google Docs and Google Slides. If you wish to 
use Google Sheets you must first sign up using a Gmail account. Once you have signed up and signed 
in you are ready to start creating and working on spreadsheets. Google Sheets contains less advanced 
features and tools than Microsoft Excel, however it does allow you to get Add-ons which are apps that 
you can use in conjunction with the program you are using in order to increase functionality.  

 

Device Specific Spreadsheet Processing Apps 

Apple devices usually come with a spreadsheet processing app that can only be used on Apple devices. 
Currently, Apple Mac computers, iPhone and iPads come with the Apple Numbers app. You can use 
this app to create spreadsheets, graphs, tables and the like. Mobile android devices (any mobile device, 
laptop or desktop computer not created by Apple) may also contain spreadsheet apps by default. For 
example, Samsung phones come with the Polaris office suite which can be used to work with Microsoft 
Excel files among other file types from the Microsoft suite.  

 

Choosing The Right Software For You  

Before you begin creating and working with spreadsheets, it’s important to decide which software 
program is most appropriate for your needs. If you want to create a complex spreadsheet or one for 
professional use it is best to use a program like Microsoft Excel that contains more advanced formatting 
and editing features. If you want to create a less complex spreadsheet that doesn’t require much 
formatting, a program like Google Sheets may be more suitable. If you don’t have access to a laptop or 
desktop computer, you can use one of the many mobile spreadsheets apps as discussed above. 
Remember that spreadsheet software can be used in conjunction with each other. For example, you 
may begin creating a file in Google Sheets before downloading it as a Microsoft Excel file so you can 
open it in Excel where you can use more advanced formatting and editing features before importing it 
again to Google Sheets for sharing with others. 
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STARTING EXCEL FROM THE DESKTOP 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To create or edit a workbook, the first thing you 
must do is start Excel. The first time you use 
Excel you will need to open it from the taskbar 
Search the web and Windows bar or the All 

apps list in the Start menu. You can then choose 
to pin it to the Start menu or the taskbar so that 
you can access it more quickly and easily the next 
time you use it.  

Try This Yourself: 

 

Before you begin, ensure 
that your computer is 
switched on and the 
desktop is displayed… 

 
If there is no Excel icon in 
the taskbar at the bottom of 
the desktop, click on the 
Windows icon in the 
taskbar, as shown, to 
display the Start menu 

 
Click on All apps to display 
a list of all the apps on your 
computer 

 
Scroll down to the E section 

Excel 2016 is listed here… 

 
Click on Excel 2016 to start 
Excel 

 
Right-click on the Excel icon 
in the taskbar to display a 
menu of options, as shown, 
then select Pin this 
program to taskbar 

You can now click on this 
icon to open Excel from the 
desktop. This icon will 
remain in the taskbar unless 
you remove it… 

 
Repeat step 5 to select 
Close window to close 
Excel 

 
Click on the Excel icon in 
the taskbar to open Excel 
again 

 

1 

5 

For Your Reference… 

To add an Excel icon to the desktop taskbar: 

1. Display the Start menu, then click on All 
apps 

2. Right-click on Excel 2016 

3. Select Pin to taskbar 

Handy to Know… 

• You can start Excel by clicking in the taskbar 
Search… bar, typing excel, then clicking on 
Excel in the list of search results. 

• You can pin Excel to the Start menu by 
displaying the All apps list, right-clicking on 
Excel 2016 and selecting Pin to Start. 

S
am

ple



BSBITU212 - Create And Use Spreadsheets 

© Watsonia Publishing Page 4 Chapter 1 - Getting to Know Excel 2016 

UNDERSTANDING THE EXCEL START SCREEN 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Unless you start Excel with a specific data file, 
Excel 2016 will open with the Excel start screen 
displayed. This acts as a gateway into Excel and 
from this initial screen you can choose what kind 

of workbook you want to work with. You can 
choose to work with a recent file, open an existing 
file, or create a new file using the available 
templates.  

The Excel 2016 Start Screen 

In Microsoft Excel your data is stored in a file referred to as a workbook. 

The Excel 2016 start screen is very helpful if you want to quickly access files you have worked on 
recently or create a new workbook file based on one of the available templates (including the default 
Blank workbook template). It acts as a gateway into the program. 

If you have already worked on workbooks, a list of recent files will display below Recent in the green 
pane to the left of the screen. If you haven’t worked on any workbooks yet you can open existing files by 
clicking on Open Other Documents (below Recent in the left green pane). This allows you to open an 
existing workbook file from your computer or OneDrive.  

The right side of the start screen displays thumbnail previews of available templates you can use to 
create a new workbook. It also contains the Search for online templates box, which you can use to 
search the internet for additional templates.  

Templates are simply layouts that have already been created which you can customise to suit your 
needs and then enter relevant data. If you want to start with a clean slate you can choose the Blank 
workbook template – you’ll probably find this is the one you’ll use the most.  

In the top right corner of the start screen you’ll see information about the account you’ve used to sign 
into Windows, as well as commands such as Microsoft Excel Help, Minimise, Restore Down (or 
Maximise) and Close. 

The start screen will only display when you launch the Excel 2016 application directly – that is, by 
clicking on Excel 2016 in the All apps list in the Start menu, searching for Excel and clicking on it in the 
search results, or clicking on the taskbar icon if the application has been pinned to the desktop taskbar.  

Excel 2016 can also be started by double-clicking on a workbook file in File Explorer. When this occurs 
Excel 2016 will bypass the start screen shown above and open the workbook directly. 
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HOW EXCEL 2016 WORKS 
 

 

 

 

  

 

For a new user the Microsoft Excel 2016 screen 
can seem intimidating. However, you’ll soon see 
that it is made up of three key areas. The data 
you type is placed on a worksheet. The data 

within the worksheet can be manipulated and 
changed using commands on the ribbon. The 
worksheet is part of a larger entity known as a 
workbook which is controlled on the Backstage. 

The Worksheet 

A worksheet appears as a number of 
rows and columns which form 
squares known as cells. Everything 
you type in Excel is entered into 
these cells. In the simple business 
plan shown to the right there are 
numbers and words entered into a 
worksheet. Formulas are also 
entered that automatically perform 
calculations. The worksheet is part of 
a larger entity known as a workbook 
– workbooks can be filed away for 
future use or for sharing and can 
also be printed. 

The Ribbon 

When you need to do something with the data in a worksheet, such as format it, colour it, analyse it, 
move it, copy it, and much more, you’ll find all of the relevant commands on the ribbon. The ribbon 
has commands organised thematically using a series of tabs across the top. 

The Backstage View 

When you want to do 
something with the data in your 
workbook, such as save it so 
that you can access it again 
later, print it, share it with a 
colleague, send it to your boss, 
protect it from prying eyes, or 
whatever, you will need to 
access the Microsoft Office 
Backstage area of Microsoft 
Excel. The Backstage is 
accessed using the FILE tab 
on the ribbon. Rather than 
offering you commands on a 
ribbon, Backstage occupies 
the entire screen and has a 
series of options down the left 
side. Here the Print option is 
active, and that is why you can 
see a preview of the worksheet 
and a series of print-related 
options. 
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USING THE RIBBON 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The ribbon is the command centre for Microsoft 
Excel. It provides a series of commands 
organised into groups and placed on relevant 
tabs. Tabs are activated by clicking on their 

name to display the command groups. Commands 
are activated by clicking on a button, tool or gallery 
option. Everything you could possibly want to do in 
Excel will be found somewhere on this ribbon. 

Try This Yourself: 

 Before you begin ensure 
Excel has started and you 
have a blank workbook 
open… 

 
Examine the groups on the 
Home tab of the ribbon 

These are the most 
commonly used commands, 
including copy and paste, 
font and number formatting, 
styles and editing... 

 
Click on the Insert tab 

The commands on this tab 
are used to create tables, 
illustrations, charts, headers 
and footers, text objects and 
symbols... 

 
Click on Shapes in the 
Illustrations group  

A gallery of shapes will 
appear which can be inserted 
into the worksheet… 

 
Click on some of the other 
tabs across the top of the 
ribbon (Page Layout, 
Formulas, etc.) and examine 
the commands on them 

Some of these open “dialog 
boxes”... 

 
On the View tab, click on 
Zoom in the Zoom group to 
display the Zoom dialog box 

 
Click on [Cancel] then click 
on the Home tab 

 

2 

3 

For Your Reference… 

To use the ribbon: 

1. Click on a tab to display the commands 

2. Click on a button to activate a command, 
display a gallery, or display a dialog box 

Handy to Know… 

• Additional tabs known as contextual tabs 
appear in specific circumstances. For 
example, if you insert a picture, the Picture 
Tools: Format tab will appear. This provides 
quick access to all of the tools you may need 
in order to modify and work with the picture. 

5 

Dialog boxes like this one provide settings or 
options for you to choose from. For example, in this 
one you can zoom the screen by varying 
percentages. We won’t actually do anything at this 
point. You’ll get plenty of opportunity for using 
dialog boxes at a later stage. 
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USING RIBBON KEY TIPS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

  

Try This Yourself: 

 

Before starting this 
ensure Microsoft Excel 
2016 has started… 

 
Press  to display the 
KeyTip badges for the 
tabs 

 
Press  to display the 

Page Layout tab and to 
see the KeyTip badges 
for these commands 

 
Press  to display the 

Margins options 

You could use the  or 

 keys to move through 

the options, or  to see 

Custom Margins… 

 
Press  twice to return 

to the Tab level of 
KeyTips 

 
Press  to access the 

Formulas tab 

 
Press  five times and 

notice that Logical is 
selected 

 
Press  to see a list of 

Logical functions, then 
press  several times to 

move down the menu 

 
Press  to abort the 

operation 

 

1 

Usually one would access commands on the 
ribbon by clicking on them with a mouse, 
however you can also use the keyboard. When 
you press the  key on the keyboard 

alphabetical labels, known as KeyTip badges, 
appear on the ribbon. Pressing a key on the 
keyboard will activate the corresponding command 
just as if you’d clicked on the command. 
 

2 

3 

For Your Reference… 

To use KeyTip Badges to access commands: 

1. Press  to display the KeyTip Badges 

2. Press the letter key of the command or tab 
that you want to select  

Handy to Know… 

• You can still use the shortcut keys for menu 
commands that were available in previous 
versions of Office. For example,  +  

applies bold to selected text. 

3 
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UNDERSTANDING THE BACKSTAGE VIEW 
 

 

 

 

  

 

The ribbon lets you work on the content in a 
document so that you can add more content, 
format it, insert pictures into it, copy it, and much 
more. The Backstage view, which is accessed 

using the File tab, lets you do something with the 
content you create, such as save it for later use, 
print it on paper, send it via email, and more by 
using the options found in Backstage view. 

The Backstage View 

The File tab on the ribbon is not a normal tab. Clicking on the File tab launches a mini-program within 
Microsoft Excel known as Backstage view. Backstage, as it’s known for short, occupies the entire screen. 

At the left of the Backstage is a 
navigation pane which is made 
up of tabs. These tabs provide 
you with access to various 
operations, such as printing, 
saving and sharing. They can 
also provide you with 
information about your 
workbook such as the file size. 

Clicking on one of these tabs 
displays a range of options 
associated with the particular 
operation. 

The whole underlying purpose 
of Backstage is to let you 
protect your data, share it with 
others, and provide you with 
valuable information about your 
workbook. Depending on what 
type of workbook it is and what 
has been done to it, different 
information may display when 
the Info tab is selected. 

 

Backstage Tabs 

The Backstage tabs provide more options for working with a document. 

 
Info Provides status information about the current workbook and lets you manage 

versions and permissions. 

New Lets you create a new workbook and provides access to a gallery of inbuilt 
templates and ready access to a range of online templates. 

Open Provides a list of recent workbooks as well as the option to search through 
your Computer, OneDrive or other place, to find what you are looking for. 

Save Saves your current workbook (if already saved to a location) or prompts you to 
save to a location. 

Save As Allows you to name your workbook and save it to a location. 

Print Allows you to print the current workbook and preview it. 

Share Allows you to share your workbook with other people via email, online 
presentation, blog or Cloud (OneDrive). 

Export Allows you to create a PDF/XPS document or change the file type of your 
workbook. 

Close Closes your current workbook. 

Account Contains product and user information. 

Options Presents you with a range of options which assist in the creation and editing of 
your workbook. 

Feedback Allows you to provide Microsoft with feedback regarding Excel 2016. 

S
am

ple



BSBITU212 - Create And Use Spreadsheets 

© Watsonia Publishing Page 9 Chapter 1 - Getting to Know Excel 2016 

USING SHORTCUT MENUS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In addition to the ribbon, Excel also features 
shortcut menus (also known as contextual 
menus) that appear when you right-click in an 
area on the screen or on an object. The content 

of the menu will vary depending upon where you 
click. Shortcut menus provide an alternative (and 
usually a quicker) way to searching the ribbon to 
find a specific operation or command. 

Try This Yourself: 

 

Before you begin ensure 
Excel has started and you 
have a blank workbook 
open… 

 
Click in cell B2 (column B, 
row 2) in the worksheet, then 
click with the right mouse 
button to display a shortcut 
menu 

Because you have clicked in 
a worksheet cell the menu 
includes a number of options 
specific to what can be done 
in and with the cell... 

 
Click anywhere else on the 
worksheet with the left mouse 
button to close the shortcut 
menu 

 
Point to any of the tabs on 
the ribbon 

 
Right-click on the tab to 
display a shortcut menu 

This menu differs from the 
previous one and displays 
toolbar and ribbon options 
instead of text options. Excel 
has made an educated guess 
about what you want to do 
based upon what you have 
clicked... 

 
Click anywhere in the 
worksheet with the left mouse 
button to close the shortcut 
menu 

 

1 

For Your Reference… 

To display a shortcut menu: 

1. Point to the object or area of the screen on 
which you want to perform an operation 

2. Right-click to display the shortcut menu 

Handy to Know… 

• Once a shortcut menu appears, the options 
in it are selected by clicking on them with the 
left mouse button, or pressing the letter 
underlined in the menu option. 

4 
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UNDERSTANDING DIALOG BOXES 
 

 

 

 

  

 

Dialog boxes contain a series of controls that are 
used to adjust settings for a particular aspect of a 
worksheet or cell. They appear either when you 
click on a dialog box launcher at the bottom 

right corner of a ribbon group, or when you click on 
a command that displays a dialog box. Dialog 
boxes are often used for adjusting some of the 
more advanced aspects of a worksheet or cell. 

Typical Dialog Box Controls 

Dialog boxes have various tools to help you perform tasks. These tools are known as controls and 
some typical ones are shown below. 

 

Text boxes are 
used to enter 
details such as 
font or size.  

Check boxes 
turn settings 
either on or off. 
When on they 
display a tick and 
therefore these 
controls are also 
known as tick 
boxes. 

Command buttons provide a means of saving the 
changed settings [OK], or closing the dialog box 
without accepting any changes made [Cancel]. 

Tabs are used to provide more 
settings on the one dialog box. 

Preview boxes 
provide a preview of 
what the selected 
settings will look like. 

Drop arrows 
provide a list of 
options for the text 
box when the arrow 
is clicked. The list 
“drops down” from 
the arrow. 
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UNDERSTANDING THE QUICK ACCESS TOOLBAR 
 

 

 

 

  

 

The Quick Access Toolbar, also known as the 
QAT, is a small toolbar that appears at the top 
left corner of the Excel window. It is designed to 
provide access to the command tools you use 

most frequently, such as Save. By default the QAT 
also contains the Undo and Redo buttons. You can 
add buttons to the Quick Access Toolbar to make 
finding your favourite commands easier.  

The Quick Access Toolbar 

The Quick Access Toolbar is positioned at the top left corner of the Excel 2016 screen. In its 
default state, it includes the Save tool, the Undo tool and the Redo tool. 

Customising the Quick Access Toolbar 

Appearing immediately to the right of the Quick Access Toolbar is the Customise Quick Access 
Toolbar tool. Clicking on this tool displays a list of commonly used commands that you can add to 
the toolbar. You can select the items that you want to add from the list by clicking on them. The ticks 
that appear to the left of the menu options show which options already appear on the Quick Access 
Toolbar. 

You can also add commands to the Quick Access Toolbar by right clicking on a command in the 
ribbon and selecting Add to Quick Access Toolbar.  

 

 

The Save Tool 
The Undo Tool 

The Redo 
Tool 

You can also add commands to the Quick Access Toolbar by right clicking on a command in the 
ribbon and selecting Add to Quick Access Toolbar.  
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UNDERSTANDING THE STATUS BAR 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The status bar is the bar across the bottom of 
the Excel window. It is a very useful aid that tells 
you the current status of Excel, performs quick 
calculations on the selected range in the 

worksheet, and allows you to zoom in and out of 
the worksheet. It also includes tools that can 
change the worksheet view. You can customise the 
status bar to change the information shown. 

1 2 3 4 5 7 6 

 
Status 
Indicator 

 

The Status Indicator indicates the current status of Excel and the 
worksheet. The most common indicator you’ll see here is Ready 
indicating that Excel is ready and waiting for you to do something. 

 

Average This tells you the average value in the cells currently selected in the 
worksheet – providing the cells contain numeric data. Selected cells are 
the ones that have the active cell indicator around them and are 
commonly referred to as a range of cells. Obviously for a calculation to 
be performed there will need to be numbers in the active range of cells.  

 

Count This tells you how many non-empty cells are in the cells currently 
selected in the worksheet.  

 

Sum This tells you the sum total of the cells currently selected in the 
worksheet – providing the cells contain numeric data.  

 
View Tools The Worksheet View tools allow you to change the view of the 

worksheet. You can select from Normal, Page Layout and Page Break 
Preview. 

 
Zoom Slider The Zoom Slider indicates the current zoom level, where the centre 

mark indicates 100%. You can either drag the marker to the left or right, 
or click on a specific point of the slider to set a zoom percentage. You 
can also click on the buttons at either end of the slider to zoom in or 
zoom out. 

 
Zoom Level This button displays the current zoom percentage. If you click on the 

button, the Zoom dialog box will appear so that you can select a specific 
zoom percentage. 

 

What appears on the status bar can vary greatly. The status bar on your screen may not exactly 
match the example shown above. 

One way you can change your status bar is by right-clicking on the status bar itself and selecting 
from the shortcut menu any additional tools you may want to add to it. 
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